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Disclaimers 

 
• The content of this manual is subject to change without prior notice. 

• The reproduction or transfer of this manual in any form whatsoever is prohibited without the prior written 

permission of the Noise Laboratory Co., Ltd. (NoiseKen). 

• Although every effort has been made to ensure that the content of this manual is accurate and complete, 

please contact NoiseKen if you find any unclear points, errors, omissions, or other inconsistencies. 

• NoiseKen will not be liable for any damages that occur due to improper usage of this product by the 

customer, failure to follow the information in this manual, or repair or modifications performed by a third 

party other than NoiseKen or a party designated by NoiseKen. 

• Regardless of the above, NoiseKen will not be liable for any test results obtained using this product or for its 

effects on the tested equipment. 

• The trademarks and company names appearing in this manual are trademarks or registered trademarks of 

their respective companies. In this manual, the trademark symbol (TM) and registered symbol (R) are 

omitted. 

• Security Export Control System: Requirements for Exporting This NoiseKen Product 

Although this product does not come under rows 1 to 15 of Appended Table 1 of the Export Trade Control 

Order, it comes under the restricted goods catch-all in row 16. For this reason, you must submit an export 

declaration to NoiseKen before exporting this product outside Japan or temporarily taking it outside Japan 

to enable us to conduct a confirmation screening of the final customer, final application, and other details. In 

the provided information, the customer will be requested to confirm that the final destination country, final 

customer, final application, and other details in the export declaration comply with the restrictions in row 16 

of Appended Table 1 of the Export Trade Control Order. 

 

To ensure strict compliance with export control laws, submission of an export declaration is required. Also, 

when reselling the product at a location inside or outside Japan, the repurchaser must also be notified of 

above information. 

 
* Because the above information is based on laws and regulations, it is subject to change due to revisions in the 

applicable laws and regulations. For details on the control and export procedures in laws and regulations, please 

contact the applicable government agency (such as the Ministry of Economy, Trade and Industry; Trade and 

Economic Cooperation Bureau; Trade Control Department; Security Export Control Policy Division). 
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1. Software Licensing Terms 
 
1. Usage Limitations 

Please use the Software for the purposes described in the instruction manuals or the 
specifications. Do not use the Software for purposes other than these. 

 
2. Intended Users 

Please ensure that individuals who use the Software have received the appropriate training and 
practice with regard to the entire system in which the Software runs, including the usage 
environment, equipment safety, and operating methods. 

 
3. Ability to Make Copies 

The Software may be installed and used on multiple personal computers by individuals who are 
members of the business location (factory, branch office, business office, etc.) that purchased the 
Software. 

 
4. Handling of Intellectual Property Rights 

The Software and the intellectual property rights including copyrights for the Software belong to 
NoiseKen. 

 
5. Usage Period 

The usage period designated by NoiseKen shall take effect when the installation of the Software 
or the prescribed procedure for use, whichever is later, has been completed by the Customer, and 
the Customer's right to use the Software shall be deemed to have expired at the end of this usage 
period. 

 
6. Usage Termination Conditions 

If the Customer has violated any of the provisions in this document, or has infringed on the 
copyrights or other intellectual property rights of NoiseKen, NoiseKen shall have the ability to 
revoke the Customer's license to use the Software. 

 
7. Procedures Upon Usage Termination 

The Customer shall promptly uninstall the Software. (If other instructions have been issued by 
NoiseKen, these shall be followed by the Customer.) 

 
8. Disclaimer 

NoiseKen and its dealers and affiliates will not be liable for any customer damages arising from the 
use of this software or for claims of damages by third parties against customers except in the case 
of intentional or gross negligence by NoiseKen, its dealer, or affiliates. 

 
9. Prohibitions 

The following actions are prohibited with regard to the Software. 
(1) Modifications, additions, and other alterations to the functionality of the Software 
(2) Any form of reverse engineering, including decompilation and disassembly, of the Software 
(3) Reselling, transferring, redistributing, licensing, etc. of the Software, or the accessories 

provided by NoiseKen for the Software, to third parties 
(4) Storing the Software, or the information, documentation, and the like provided by NoiseKen for 

the Software, on a network in a state wherein it may be conveyed to a third party 
 
10. Handling of USB and other protection keys 

The software provided by NoiseKen may require USB or other protection keys. 
(1) If a protection key is included in the accessories, the protection key must be mounted in the 

computer where the software is used. 
(2) As a general rule, the protection key is not reissued. In the event that the protection key is 

damaged or lost, please contact the NoiseKen Sales (or Repair) Division. 
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2. IMPORTANT SAFETY PRECAUTIONS 
 
This software performs visualization of electromagnetic field emissions in space. Important 
information for safe operation when performing visualization using this software is provided below, 
and so be sure to read it carefully before use. 
Also, be sure to carefully read this manual and the instruction manual for each device to be used 
before using this software. 
 

1. Incorrect or careless operation could result in a fatal injury. 

2. Avoid use in locations exposed to high humidity and large amounts of dust. 

3. When making connections, electric shock can occur due to contact with the supply 

voltage, and so before performing any connection work, be sure to turn off the power 

to the each device, and check that no power is flowing. 

4. Do not turn off the power to the each device or disconnect any cables while this 

software is running. This could cause PC operation to become unstable or the OS to 

malfunction. Be sure to always exit this software before turning off the power to the 

each device.
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3. Item Check List 
 

Before starting use, check that the parts and accessories below are 
included with the product. 

 
A B C 

 

 

 

D E F 

  

 
G H I 

 

 

 
 

 
 A: Web camera 

・ Main part ································································· 1 
・ Warranty ································································· 1 

 B: LAN cable (2 m) ····························································· 1 
 C: USB extension cable (2 m) ··············································· 1 
 D: USB GPIB controller 

・ Main part ································································· 1 
・ Installation guide ······················································· 1 
・ Installation media ······················································ 1 

 E: USB protect key ······························································ 1 
 F: Camera tripod 

・ Main part ································································· 1 
・ Storage bag ····························································· 1 
・ Manual ···································································· 1 

 G: Installation CD (EPS-02Ev2)············································· 1 
 H: User Guide (This Manual) ················································ 1 
 I: Storage case ·································································· 1 
 
* The key of A, G and H are included in the upgrade version. 
* The key of E, G and H are included in the secondary license version. 
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4. Introduction 
 

Thank you for purchasing the EPS-02Ev2 Space-Magnetic Field Visualization System. 

Before using the EPS-02Ev2, be sure to carefully read this manual to ensure that you 

maximize its performance when operating the EPS-02Ev2. 

 

� This User Guide is provided to ensure that people who follow the operating procedures 

and safety information can safely use the EPS-02Ev2 and maximize its performance. 

� Place this User Guide in a location where it is easily accessible whenever operating the 

EPS-02Ev2. 

 

4－1. Features 

 
Enabling visualization of electromagnetic field emissions in space 

� An electromagnetic field measurement sensor is used to perform frequency analysis with a 

spectrum analyzer and to map to the emission location of the actual image. 

� The emission location is mapped relative to the sensor location recognized using the web 

camera. 

� An area of up to 64 blocks × 48 blocks can be measured. 

� A superimposed image of the measurement strength distribution diagram and web camera 

image are displayed for enabling easy identification of the emission source. The density of 

the strength distribution and frequency range can be specified. 

� Measured results can be saved to a file, and the content of the measurement results and file 

can be compared for enabling visualization of the effects of corrective actions. 

� Measurement sensor location detection by hand instead of using a positioner is possible for 

enabling easy measurement in cramped spaces, outdoors, and other difficult-to-access 

locations. 

 

 

 



 

 5

5. Contents 
 

1. SOFTWARE LICENSING TERMS ............................................................................. 1 

2. IMPORTANT SAFETY PRECAUTIONS..................................................................... 2 

3. ITEM CHECK LIST ..................................................................................................... 3 

4. INTRODUCTION ........................................................................................................ 4 

4－1.Features ····················································································································· 4 

5. CONTENTS ................................................................................................................ 5 

6. OVERVIEW ................................................................................................................ 8 

6－1.Notation Used in This Guide ···························································································· 8 

6－2.EPS-02Ev2 Features ····································································································· 8 

6－3.Measurement Principle ··································································································· 9 

7. SYSTEM CONFIGURATION DIAGRAM .................................................................. 10 

7－1.System Configuration Diagram ························································································ 10 

7－2.Functions of Each Device ······························································································ 11 

8. PREPARATION ........................................................................................................ 12 

8－1.System Backup ··········································································································· 12 

8－2.System Connections ····································································································· 12 

9. OPERATION PROCEDURE ..................................................................................... 13 

9－1.Starting and Exiting the Software ····················································································· 13 

Starting the Software ............................................................................................................................. 13 

Exiting the Software ............................................................................................................................... 13 

9－2.Image Recognition Settings ···························································································· 14 

Image Recognition Setting Dialog Box .................................................................................................. 14 

Device Name ......................................................................................................................................... 14 

Device Filters ......................................................................................................................................... 15 

Image Recognition Setting .................................................................................................................... 16 

9－3.Communication Settings ································································································ 17 

Communication Settings Dialog Box ..................................................................................................... 17 

Equipment Name ................................................................................................................................... 17 

Interface ................................................................................................................................................. 18 

IP Address ............................................................................................................................................. 18 

GP-IB Address ....................................................................................................................................... 18 

Serial Number ........................................................................................................................................ 18 

9－4.New Measurement (Setting Measurement Conditions) ························································· 19 



5.Contents 

 6

View Window ......................................................................................................................................... 19 

Condition Tab ........................................................................................................................................ 20 

Image Division Size ............................................................................................................................... 20 

Capturing ............................................................................................................................................... 21 

Frequency ............................................................................................................................................. 21 

Spectrum Analyzer ................................................................................................................................ 21 

Antenna Factor ...................................................................................................................................... 22 

9－5.New Measurement (Performing Measurement) ·································································· 23 

Performing Measurement...................................................................................................................... 23 

Deleting Measurement Data ................................................................................................................. 24 

Recapturing Camera Image .................................................................................................................. 25 

9－6.Measurement Data Analysis ·························································································· 26 

Measurement Data ................................................................................................................................ 26 

Auto Distribution .................................................................................................................................... 27 

Interpolation .......................................................................................................................................... 27 

Unit ........................................................................................................................................................ 28 

Transmittance ....................................................................................................................................... 28 

Frequency Range .................................................................................................................................. 29 

Measurement Information ..................................................................................................................... 29 

Memo .................................................................................................................................................... 29 

Matching Map View Data ...................................................................................................................... 30 

Exporting Measurement Data ............................................................................................................... 31 

Antenna Factor Reloading .................................................................................................................... 32 

10. SETUP ................................................................................................................. 33 

10－1.Important Notes on Setup ···························································································· 33 

10－2.Installation of Camera Driver ························································································ 33 

10－3.Network Address Settings ···························································································· 33 

10－4.Installing the Software ································································································· 34 

11. ANTENNA FACTOR EDITOR ............................................................................. 36 

11－1.Overview ·················································································································· 36 

11－2.Starting and Exiting the Software ··················································································· 36 

Starting the Software ............................................................................................................................. 36 

Exiting the Software .............................................................................................................................. 36 

11－3.Description of the Screen ····························································································· 36 

Entire Screen ........................................................................................................................................ 36 

File Menu .............................................................................................................................................. 37 

Pop-up Menu (Right-Click) .................................................................................................................... 37 

11－4.Operation Procedure ·································································································· 38 

New Measurement ................................................................................................................................ 38 

Open...................................................................................................................................................... 38 



5.Contents 

 7

Import ..................................................................................................................................................... 38 

Export..................................................................................................................................................... 38 

11－5.Editing Correction Data ································································································ 39 

Set frequencies ...................................................................................................................................... 39 

Level correction values .......................................................................................................................... 39 

11－6.Sample Antenna Factor ······························································································· 40 

12. SPECIFICATIONS ............................................................................................... 41 

12－1.Specifications ············································································································ 41 

12－2.System Requirements ································································································· 41 

12－3.Supported Spectrum Analyzers ····················································································· 41 

12－4.Antenna Frequency Characteristics ················································································ 42 

13. WARRANTY ........................................................................................................ 45 

14. NOISE LABORATORY SUPPORT NETWORK .................................................. 46 

 



 

 8

6. Overview 
 

6－1. Notation Used in This Guide 

 
The marks used in this guide and their meanings are provided below. 

 Provides an additional explanation. 

 Indicates a location for further reference. 

 Indicates a setting restriction. 

 Indicates that you must check before usage. 

【 】 Indicates information inscribed on the panel of this testing device. 
 

6－2. EPS-02Ev2 Features 

 
＊ Measurement sensor is detected from the image for recognizing the measurement 

location 
The measurement object and measurement sensor are captured by a camera, and the 
measurement sensor is found within the image for identifying the measurement location. The 
recognized measurement location is a relative location within the camera image. 
Any user-selected color can be specified for the measurement sensor. However, selecting a 
color with the same tone as the background color will result in a reduced rate of recognition 
and even mistaken recognition in certain cases. 
The measurable range is the area shown in the camera, but it is restricted to a range that can 
be recognized by the measurement sensor. 
 

＊ Automatic control by software 
Measurement sensor recognition from the camera image and control of the spectrum 
analyzer are performed automatically. The measurement results can be output as a CSV file, 
and the image can be output in BMP format. 
Also, because the software is a Microsoft Windows application, it provides an 
easily-accessible interface that uses mouse operations while viewing the screen. 
 

＊ Visual display of measurement results 
The measurement strength distribution and camera image are displayed as a superimposed 
image on the computer screen. Also, the mouse pointer in the image can be used to confirm 
measurement results for any selected position. 
In addition, an interpolation view of the surrounding strength can be used to provide easier 
assessment of the generation points. 
 

＊ Full emission analysis function for measurement points 
Data can be collected for the entire measurement frequency range generated from the 
measured object in a single measurement. The emission map for each frequency band is 
also redisplayed by simply specifying the frequency band. 
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6－3. Measurement Principle 

 
The EPS-02 system performs two main operations for enabling visualization of the electromagnetic 

field. First, it performs image recognition that identifies the measurement sensor location from the 

recording image. Second, it provides a color-coded distribution on the image indicating the strength of 

the signals detected by the measurement sensor. 

In image recognition, 640 x 480 pixel video from the camera is monitored in real time, and a 

specific color only is extracted based on the specified parameters for "hue", "brightness", and 

"saturation". By finding the focal point of the area with the specific color, the location of the specific 

object (measurement sensor) can be found in the image. 

If an object with the same color as the specified color, but that is not the measurement sensor, 

appears in the image, the measurement sensor location cannot be recognized correctly because the 

focal point of all objects of this color is calculated. Therefore, the parameter settings for "hue", 

"brightness", and "saturation" that are used to detect the measurement sensor, the brightness and 

light exposure in the recording location, and selection of the lighting are important factors. Also, the 

cover of the measurement sensor must be adjusted based on the color of the measurement object. 

Substances suitable for the measurement range are used for the measurement sensor, and a 

spectrum analyzer is used as the measuring instrument for enabling measurement of the 

electromagnetic field area. The spectrum import count and frequency range vary depending on the 

measurement sensor and measuring instrument. The measurement data is mapped to a position 

specified by image recognition. The method of capturing data at the same position can be selected 

from MAX HOLD, PEAK HOLD, FREE RUN, and SINGLE. 

After measurement is completed, the frequency range that you want to view can be selected for 

creating a strength distribution combined with the image.  

There are no guidelines or restriction values for the electrical field strength of the proximity field. 
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7. System Configuration Diagram 
 

7－1. System Configuration Diagram 

 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

① Web camera 

This captures the image of measurement object. 

② Control PC 

This controls the various devices and conducts electromagnetic field measurement. 

③ Spectrum analyzer 

Support is provided for some spectrum analyzers described in [12－3.Supported Spectrum 

Analyzers] on page 41. Please consult with NoiseKen for use of spectrum analyzers that are not 

supported. 

④ Preamplifier (Optional) 

EPS-02 series or other high performance preamplifier which can be used for various applications. 

⑤ Measurement sensor (Optional) 

The electrical field probe, magnetic field probe, and other measurement sensors are selected 

based on the frequency application. NoiseKen optional probes and commercially-available 

electromagnetic field probes can be used. 

 

① 

USB cable 

② ③ 
LAN cable or 
GP-IB cable 

N(P)－N(P) 
coaxial cable 

④ 
⑤ 

N(P)－BNC(P) 
coaxial cable 
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7－2. Functions of Each Device 

 
① Web camera 

This is a general-purpose web camera. The image of measurement object is captured and 

transferred to the PC. The web camera is connected to the PC by a USB cable. If necessary, the 

connection can be extended by a USB extension cable. 

② Control PC 

This enables running of system control software. This software imports images from the web 

camera, identifies the measurement sensor within the image, and finds its location. After 

frequency analysis is performed by the spectrum analyzer, the control PC receives the 

measurement results and maps them to that location. 

③ Spectrum analyzer 

This performs frequency analysis of the signals from the measurement sensor and sends the 

spectrum data to the PC. The spectrum analyzer is connected to the PC using the supplied GP-IB 

or LAN cable. 

④ Preamplifier (Optional) 

This amplifies the signal detected by the measurement sensor by 41 dB. Connect the 

measurement sensor to the INPUT terminal and the spectrum analyzer to the OUTPUT terminal. 

⑤ Measurement sensor (Optional) 

A sensor (probe) is used based on the measurement target frequency and electrical or magnetic 

field. Attaching a special cover to the sensor is recommended for improving the recognition rate. 
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8. Preparation 
 
 

CAUTION 
Environments having poor signal reception 
In environments exposed to extremely large amounts of external noise, the equipment may be unable 
to realize its maximum performance. 
Even when indoors, the equipment can be affected by lighting and other electronic devices. During 
measurement, try to minimize the effect of the electromagnetic environment to prevent external noise 
from affecting the equipment. Also, certain PCs may generate large amounts of noise emissions and 
may not be suitable for measurement systems. 
 
 

8－1. System Backup 

 

NoiseKen provides an optional service (additional charges apply) for installing the EPS-02Ev2 

program in your PC before providing the program, but if the program is erased, install it from the 

supplied CD. The installation procedure is included in the "Readme.txt" file. Copy the content of the 

CD to a hard disk, removable disk, or other location and store it there in case of loss. 

The CD included with the web camera mounted on the PC is provided to the customer, but it is also 

recommended that you create a backup of this CD in the same way and store it in a separate location 

from the original disk. 

For details of setup, see "10. Setup" (P33). 
 

8－2. System Connections 

 
① Connect the web camera to the PC using the USB cable. Any commercially-available USB cable 

can be used, but it must be a cable that supports the USB 2.0 standards. Be aware that the USB 
2.0 standards limit the cables to a maximum of 1 extension and maximum length of 5 m. 

② The spectrum analyzer and PC are connected by a GPIB or LAN cable. A commercially-available 
cable can be used for the LAN cable. Use a one-to-one local connection without passing through 
the site LAN or hub. 

③ Connect the measurement sensor and spectrum analyzer. Use the proper conversion cable that 
matches the sensor output connector. 
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Screen displayed immediately after the software is started 

9. Operation Procedure 
 

9－1. Starting and Exiting the Software 

 

Starting the Software 
To start the software, double-click the EPS-02Ev2 shortcut icon on the desktop. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Exiting the Software 
To exit the software, click the close button on the right end of the title bar or click Exit from the File 

menu. 

Because the software cannot be closed during measurement, finish measurement before exiting 

the software. 

 

 

 

 

 

 

 

Double-click 

Click 

Click 
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Image Recognition Setting dialog box 

  

9－2. Image Recognition Settings 

 

Image Recognition Setting Dialog Box 
To open the Image Recognition Setting dialog box, click Image Recognition Setting from the 

Set menu. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Adjust the camera position so that the measurement object can be captured by the camera. 
Take the following conditions into account during adjustment. Changing camera properties or 
adjusting the lighting may be required depending on the circumstances. 

・Sufficient brightness is provided so that the measurement object and the measurement 
sensor can be fully recognized. 

・There is no object whose color is similar to that of the measurement sensor. 
 

Device Name 
Camera names are displayed in the Device Name list. If multiple cameras are connected, select 

the camera to be used from the device name list. 

 

 

 

 

 

Click 

Select a camera 
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Webcam Control screen Advanced Settings screen 

  

Device Filters 
To open the Webcam Properties dialog box, click the Device Filters button. 

In the dialog box, the camera properties, such as zoom, white balance, and anti-flicker, can be set. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

� White balance 

White balance is a function to perform color correction so that a white object appears white. If the 

light source, such as sunlight, light bulb, or fluorescent, makes the white object look bluish or 

reddish, adjust white balance. 

� Anti-flicker 

Anti-flicker is a function to reduce flicker in images. 

 

 
The Properties screen may vary depending on the model or driver version of the connected 
camera. 

 

Click 

Zoom 

Anti-flicker 

White balance 
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Image Recognition Setting 
Adjust the three parameters, Hue, Saturation, and Value, in the Image Processing Setting so 

that the color of the electromagnetic sensor can be recognized. The binarized image on the right 

side can be changed by moving the slider of each parameter. 

Hue: Sets the hue, such as red, blue, or yellow 

Saturation: Sets the intensity and purity of a hue 

Value: Sets the lightness of a color. 

 

 

 

 

 

Adjust the parameters until the electromagnetic field measurement sensor is recognized as a circle 

and no other object is recognized. If there is any object whose color is similar to that of the sensor 

in the background, hide the object or change the color of the sensor. 

Once the sensor is recognized as a circle, click OK to complete adjustment. 

 

 

 

 

 

 

 

 

 

 

 

 
Procedure for successful sensor recognition setting 

1. Set the Saturation and Value to 0. 
2. Adjust the Hue so that the sensor is most clearly recognized. 
3. Increase the Saturation gradually to remove other recognized areas around the sensor. 

Do not increase the Saturation excessively to prevent the recognized sensor area from 
being impaired. 

4. Increase the Value in the same manner. 
5. Finally, move the sensor outside of the camera view, and make sure that there is no 

object to be recognized.  
If any other object is recognized, repeat steps 3 and 4. 
When the mal-recognition is not solved even if steps 3 and 4 are repeated, start over 
from step 1. 

Desirable recognition state 
The shape of the sensor is almost circular. 
There are no recognized areas in the 
background. 

Not desirable recognition state 
The shape of the sensor is not circular. 
There are recognized areas in the 
background. 
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Communication Settings dialog 

  

9－3. Communication Settings 

 

Communication Settings Dialog Box 
To open the Communication Settings dialog box, click Communication Settings from the Set 

menu. 

In this dialog box, a remote-controlled spectrum analyzer can be set up. 

 

 

 

 

 

 

 

 

 

Equipment Name 
Select the equipment name of the connected spectrum analyzer. 

The following seven drivers are available as standard options: FSV, U3741, U3751, ESR, ESRP, 

MDO4000, and N9010A. Customized spectrum analyzer drivers are also included in this list. 

 

 

 

 

 

 
If the Equipment Name list is blank, no spectrum analyzer driver may exist. Check to see that 
spectrum analyzer drivers (*.sad) are stored in the folder where the EPS-02Ev2 executable file is 
stored (C:¥Program Files (x86)¥NoiseKen¥EPS-02Ev2, under normal conditions).

 

 

 
When NI-VISA (National Instruments) has not been installed, the Equipment Name list is blank 
even if spectrum analyzer drivers exist. In such cases, install NI-VISA according to “10－
4.Installing the Software” in page 34. 

Click 
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Interface 
Selectable interface types vary depending on the selected equipment. 

Equipment supports GP-IB only, LAN/GP-IB, or LAN/GP-IB/USB. 

 

 

 

 

 

 

 

 

 

IP Address 
The IP Address is displayed when LAN is selected as the interface with the analyzer. 

For how to set the IP address, see “10－3.Network Address Settings” in page 33. 

 

 

 

GP-IB Address 
The GP-IB Address is displayed when GP-IB is selected as the interface with the analyzer. 

Set the address to the same value as the GP-IB address of the selected equipment. 

 

 

 

Serial Number 
The Serial Number is displayed when USB is selected as the interface with the analyzer. 

Check the serial number of the selected equipment using the system confirmation screen for the 

equipment. 
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View window (before measurement) 

  

9－4. New Measurement (Setting Measurement Conditions) 

 

View Window 
To open a View window, click New Measurement from the File menu or click the New 

Measurement button on the toolbar. 

Whenever a View window is newly opened, it is numbered as follows: View1, View2, View3 ... 

These names can be changed freely when the file is saved after measurement. 

Before starting measurement, set an image division size, properties for the spectrum analyzer, and 

other conditions in the View window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
If a web camera or USB protect key is not connected, new measurement is not possible. 

 

Click 

Click 
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Conditions (before measurement) Conditions (after measurement) 

Image division size: 10 pixels Image division size: 160 pixels 

  

Condition Tab 
In the Condition tab, set the image division size, properties for the spectrum analyzer, and other 

conditions. 

Condition items can be set only before measurement. After completion of measurement, all items 

are displayed but cannot be changed. 

 

 

 

 

 

 

 

 

 

 

 

 

Image Division Size 
Set the division size by which a camera image of 640 × 480 pixels is divided. 

The image division size can be selected from 10 pixels (H: 64 × V: 48 squares), 16 pixels (H: 40 × 

V: 30 squares), 20 pixels (H: 32 × V: 24 squares), 32 pixels (H: 20 × V: 15 squares), 40 pixels (H: 

16 × V: 12 squares), 80 pixels (H: 8 × V: 6 squares), or 160 pixels (H: 4 × V: 3 squares). 

Select 20 or 32 pixels normally. 
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Capturing 
How to store spectrum data at the same measurement point (the same square of the grid) can be 

selected from SINGLE, FREE RUN, PEAK HOLD, or MAX HOLD. 

 

 

 

 

 

 

 

 

 

Frequency 
The measurable frequency range depends on the spectrum analyzer and electromagnetic field 

measurement sensor. 

The frequency unit can be selected from Hz, kHz, MHz, and GHz. 

 

 

 

Spectrum Analyzer 
To configure advanced settings for the spectrum analyzer, click the Set button next to the 

equipment name of the analyzer to open the Property dialog box. 

For details of each item, refer to the instruction manual for the spectrum analyzer. 

 

 

 

 

 

 

 

 

 

 

 

SINGLE Performs measurement only one time. 

FREE RUN Always overwrites the data. 

PEAK HOLD 

Compares the maximum values of the 

spectrum waveforms, and overwrites the 

retained value if it is not the largest. 

MAX HOLD 

Compares the maximum values of the 

spectrum waveforms on a point basis, and 

overwrites the retained values if it is not the 

largest. 

Click 
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Antenna Factor Editor Screen 

 
Items shown in the Property dialog box may vary depending on the selected spectrum 
analyzer driver. 

 

 

Notes for property settings 
� Resolution Bandwidth (RBW) 

The bandwidth of the IF filter. The smaller the bandwidth becomes, the sharper the 
spectrum waveform becomes, lowering the noise floor. 

� Video Bandwidth (VBW) 
The bandwidth of the averaging filter. The smaller the bandwidth becomes, the less 
the waveform fluctuates, lowering the noise floor. 

� Sweep time 
The RBW and VBW filters have their response times. The slower the sweep time is, 
the higher the resolution becomes, lowering the noise floor. 

� Span 
The range between the START and STOP frequencies. The narrower range results in 
the sufficient response speed of each sweeping frequency, the higher resolution, and 
the lower noise floor. 

 
Note: If the noise floor is lowered, the sweeping speed becomes slower, resulting in a longer 

measurement time. If RBW, VBW, and the sweep time are set to AUTO, the noise floor 
becomes higher, while the measurement time becomes shorter. 

 

Antenna Factor 
Select the file with the same name as the electromagnetic field measurement sensor to be used. 

This factor file is used for correction to make the frequency characteristics of the sensor linear. 

When the THROUGH file is selected, the spectrum data from the spectrum analyzer will be 

acquired as it is, without interpolation. 

 

 

 

If the original sensor is used, a factor file can be created using Antenna Factor Editor. For details, 

see “11. Antenna Factor Editor” on page 36. 
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9－5. New Measurement (Performing Measurement) 

 

Performing Measurement 
To start measurement, click the START button in the upper right of the View window. During 

measurement, the PAUSE and STOP buttons are enabled. 

To suspend measurement, click the PAUSE button to suspend measurement, and to finish 

measurement, the STOP button. 

After completion of measurement, all buttons are disabled. When performing measurement again, 

click New Measurement from the File menu or click the New Measurement button on the toolbar. 

 

 

 

 

 

Once measurement is started, the Map View and Comment tabs appear next to the Condition tab. 

In the Map View tab, only Transmittance can be changed during measurement, and all items can 

be set after completion of measurement. Items in the Comment tab can be set even during 

measurement. 

Points (squares of the grid) that have been measured are color-coded according to the peak value 

and overlaid on the camera image during measurement. In addition, the spectrum data measured 

by the spectrum analyzer is displayed in the spectrum graph area located in the lower part of the 

View window, on a point-by-point basis. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
If a directional sensor is used, maintain the same direction. 
In addition, move the sensor parallel to the measurement object. 

During measurement After measurement Before measurement 

START STOP PAUSE 
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Before deleting data After deleting data 

  

The EPS-02Ev2 software sends a sweep start command to the spectrum analyzer immediately 

after the sensor is recognized. After completion of sweeping, the software recognizes the sensor 

position again, and only when the sensor is found at the same point (position) where it was placed 

at the start of the analyzer sweeping, the spectrum data is stored.  

If the sensor is moved quickly, the point at the start of sweeping differs from that at the completion 

of sweeping, and as a result, measurement data is not stored. For spectrum analyzers with slow 

response speed, move the sensor more slowly. 

 

If the sensor is not recognized or other object is falsely recognized, reconfigure the image 

recognition setting. Click Image Recognition Setting from the Set menu to change the setting. 

Please note that it is possible during measurement. 

 

Deleting Measurement Data 
Stored measurement data can be deleted on a point-by-point basis. 

When data to be deleted is right-clicked during measurement, the Delete menu will appear. Click 

this menu to delete the measurement data for the corresponding point. 

 

 

 

 

 

 

 

 

 

 

 

 
Data can be deleted only during measurement and cannot be deleted after completion of 
measurement. 
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Before recapturing After recapturing 

  

Recapturing Camera Image 
If the STOP button is clicked after completion of measurement, the camera image switches from 

video to still image. If the still camera image includes an unnecessary object, such as the sensor, 

the camera image can be recaptured. 

Click Recapture Camera Image from the Window menu. The still image will switch to video and 

the following message will be displayed. 

 

 

 

 

 

 

 

Clicking the OK button switches the camera image from video to still image to capture a new 

camera image. To return the original camera image, click the Cancel button. 

 

 

 

 

 

 

 

 

 

 

 
Recapturing is possible as many times as needed before the file is saved. 
Note that recapturing is not possible once the file is saved. 

Click 



9.Operation Procedure 

 26

Condition tab Map View tab Comment tab 

  

9－6. Measurement Data Analysis 

 

Measurement Data 
After completion of measurement, a square pointer    will be displayed on the camera image. 

Dragging this pointer to the desired point can display the spectrum data at the relevant point. 

The pointer automatically moves to the highest level point immediately after measurement is 

complete or the file is opened. 

 

 

 

 

 

 

 

 

 

 

 

 

 

In the Condition tab, the conditions configured before measurement can be checked. The 

representation of measurement data can be changed in the Map View tab. In the Comment tab, 

measurement information and other comments can be entered. 

 

 

 

 

 

 

 

 

 

 

 

Pointer 
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Auto Distribution 
When the Auto Distribution checkbox is checked, the color map is made according to automatic 

distribution between the highest and lowest intensity. Immediately after measurement is complete 

or the file is opened, the Auto Distribution checkbox is always checked. 

 

  

 

To change the Upper/Lower Value to desired values, uncheck the Auto Distribution checkbox 

and click the Set button. The set upper/lower value settings will be reflected applied to the map 

data color bar. 

 

 

 

 

 

 

 

 

 

Interpolation 
When the Interpolation checkbox is checked, the map data image is smoothly displayed by 

interpolation of the boundaries between divisions. 

 

 

 

 

 

 

 

 

 

 

Without interpolation With interpolation 

Click 
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Transmittance: 0% Transmittance: 100% 

  

Unit 
The unit used to display measured intensity can be selected from dBµV and dBm. 

The change of unit will be applied to the color bar and spectrum graph. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Transmittance 
The transparency of the color map can be changed. 

When Transmittance is set to 100%, the map is invisible and only the camera image will be 

displayed. When Transmittance is set to 0%, the camera image is invisible at the points where 

data exist. 

 

 

 

 

 

 

 

 

 

 

Displayed in dBµV Displayed in dBm 
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Frequency Range 
If the Specified Frequency checkbox is checked under Frequency Range, the map is 

color-coded not using the peak values of the whole frequency range but using those of the 

specified frequency range, and the relevant blue zone band is displayed in the spectrum graph. 

This zone band can be moved to the right or left by dragging it, and thereby the color-map on the 

camera image changes. In addition, the width of the zone band can be changed by dragging an 

end of the band to the right or left. 

 

 

 

 

 

Clicking the Set button opens the Frequency Setting dialog box, where the frequency range for 

the zone band can be directly entered. 

 

 

 

 

 

Measurement Information 
The measurement date is automatically input in the Day field. For other items, enter information 

freely. If no information is required, leave the field blank. 

 

 

 

 

 

 

Memo 
Any information about measurement can be entered freely. In the Memo field, there is no limit of 

the number of characters. 

 

 

Click 
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After matching map view data 
 

Before matching map view data 

  

Matching Map View Data 
The same setting can be applied to all maps on the View windows that are currently open. 

When Match Map View Data in the Window menu is clicked, the map view settings of the last 

active View window will be applied to all of open View windows. The settings to be applied include 

Upper/Lower Value, Interpolation, Unit, and Transmittance. Specified Frequency is also 

applied if the START and STOP frequencies are the same among Windows. Use this function to 

compare measurement data before and after corrective actions. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click 
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Exporting Measurement Data 
Measurement data can be exported to an external file. 

Select Export from the File menu, and choose one from Map Data, Spectrum Data, and All 

Spectrum Data. The Save As dialog box will appear. 

 

 

 

 

 

 

 

 

 

In Save as type on the Save As dialog box, either CSV File or Bitmap File can be specified. 

 

 

 

 

 

 

 

 

 

 

 

� Map Data 

CSV file: The peak values for each measurement point are exported. 

BMP file: The map data image pasted on the camera image is exported. 

� Spectrum Data 

CSV file: The spectrum waveform data for the point indicated by the pointer    is exported. 

BMP file: The spectrum graph image for the point indicated by the pointer    is exported. 

� All Spectrum Data 

CSV file: The spectrum data for all measurement points are exported. 

Click 
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Old Antenna Factor: 901_6cm_Loop_v2 New Antenna Factor: THROUGH 

  

Antenna Factor Reloading 
The Antenna Factor of the measured data can be reloaded. 

Click Antenna Factor Reloading... from the File menu. The Antenna Factor Reloading dialog box 

will appear and allow the desired Antenna Factor to be specified. 

 

 

 

 

 

 

 

 

 

 

To save the reloaded Antenna Factor, click Save As... from the File menu and save the file under a 

different name. 

 

 

 

 

 

Click 
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10. Setup 
 

10－1. Important Notes on Setup 

 
This section describes setup for the software and peripheral devices. To perform setup, you must be 
logged in with administrator privileges. 
Also, it is recommended that setup be performed by some engineer with a certain degree of 
proficiency in computers, including having an understanding of Ethernet addresses and other 
terminology. 
Be aware that some details may vary for different OS versions, PC display settings, and other 
environments. 
 

10－2.  Installation of Camera Driver 

 

1) Installation of Driver 

Attached CD is set to a personal computer and the camera folder of relevance is chosen from a 

CAM folder. 

Perform Setup.exe and install a driver. 

Please install only a driver by custom installation in the case of installation implementation. 

The procedure of installation should follow the wizard of a setup. 

Installation of a camera driver is completion above. 

 

10－3. Network Address Settings 

 

1) Setting the IP Address of the PC 

From the Control Panel, select Network and Sharing Center, and click Change adapter 

settings from the list on the left side. 

 
<How to open Control Panel> 
[Windows 10] 

In the search box on the taskbar, type Control Panel, and then select Control Panel. 

[Windows 7] 

Click the Start button, and then click Control Panel. 

 

The adapters that can connect to the network are displayed. Double-click the adapter (local area 

connection) that is connected to the spectrum analyzer to display its properties. Select "Internet 

Protocol Version 4", and click to display the properties. 

 

  



10.Setup 

 34

 

Enter "192.168.99.3" for the IP address  

and "255.255.255.0" for the subnet mask,  

and click OK. 

This completes the IP address settings  

for the PC. 

 

 

 

 

 

  

2) Set the IP address of the spectrum analyzer 

For details on the spectrum analyzer settings, see the instruction manual for the spectrum 

analyzer. 

Set the IP address to "192.168.99.100" and the subnet mask to "255.255.255.0". 

 

10－4. Installing the Software 

 
1) Installing NI-VISA 

Please carry out the installation according to the installer to set the DVD-ROM that comes with 

the product National Instruments, is automatically executed. When installing, please make sure 

that you have included in the NI-VISA installed items. 

 

2) Installing the EPS-02Ev2 Software 

Load the supplied CD, and open the "EPS-02Ev2" folder. 

Run EPS-02Ev2_En.msi to start the installation process. Then, perform installation by following 

the instructions from the installer. 

 

3) Use of the supplied USB protect key 

When the software is used as a viewer, the supplied protect key is not required. For carrying out a 

measurement by controlling the peripherals, the supplied protect key is required. 

 

It is required to install the driver of the USB protect key before use. The driver file is in “JSP USB” 

folder in the attached CD. After you insert the USB protect key into a USB port of the PC where 

EPS-02Ev2 software in installed, open Device Manager and select “unknown devices” or 

“HardKey” of “other devices” and install the driver. 

 

The program can run a measurement only when the USB protect key is inserted into the PC. The 

USB protect key can be plugged into any USB port. 
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Note: This software can be installed on only one PC. However, this limitation does not apply 

when using the viewer only (measurement is not performed). When using the viewer, 

install NI-VISA and EPS-02Ev2 Software. 
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11. Antenna Factor Editor 
 

11－1. Overview 

Antenna Factor Editor is a Windows application by which an Antenna Factor file can be created and 
edited in the EPS-02Ev2 Space-Magnetic Field Visualization System. 
 

11－2. Starting and Exiting the Software 

 

Starting the Software 
Double-click FactorEditor.exe stored in the folder where the EPS-02Ev2 executable file is stored 

(C:¥Program Files (x86)¥NoiseKen¥EPS-02Ev2, under normal conditions). 

 

Exiting the Software 
Click the close button on the right end of the title bar or click Exit from the File menu. 

11－3. Description of the Screen 

 

Entire Screen 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Set 
frequencies 

 

Level 
correction 

values 

[Frequency unit] 
selection button 

[Data creation] 
button 

Data edit box 
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File Menu 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
① New Measurement 

Creates a new correction data file. 
 

② Open... 
Opens an existing correction data file (*.ant). 
 

③ Save 
Saves the correction data file being edited. 
 

④ Export 
Exports the correction data being edited to a CSV file. 
 

⑤ Import 
Imports correction data from a CSV file. 
 

⑥ Exit 
Exits the application. 

 

Pop-up Menu (Right-Click) 
 
 
 
 
 
 
 
 
① Add row 

Adds a row to the end of the correction data list. 
 

② Insert row 
Adds a row to the front of the selected correction data list. 
 

③ Delete row 
Deletes a row of the selected correction data list. 

 
  



11.Antenna Factor Editor 

 38

11－4. Operation Procedure 

 

New Measurement 
On the menu bar, select File → New Measurement. By double-clicking on the empty list, one 

record can be added. Then, set Frequency and Factor to the desired values. Up to 99 records can 

be added. 

When the necessary data input is complete, click the Data creation button to create a data file. 

The file is only available by putting it in the folder where the EPS-02Ev2 executable file is stored 

(C:¥Program Files (x86)¥NoiseKen¥EPS-02Ev2, under normal conditions). 

 

Open... 
On the menu bar, select File → Open..., and select a file with the extension .ant in the Open dialog 

box to display the data list. 

By double-clicking a data item, the data can be edited. By clicking the Data creation button after 

editing, a data file with the edited data can be created. 

 

Import 
This tool can import a CSV file that was edited by another editor. 

On the menu bar, select File → Import, and select a file with the extension .csv in the Open dialog 

box to display the data list. By double-clicking a data item, the data can be edited. By clicking the 

Data creation button after editing, a data file with the edited data can be created. 

The first row of the file to be imported must be a header row including the frequency unit character 

string. 

 
 
 
 
 
 
 
 

Export 
This tool can export Antenna Factor correction data to a CSV file. 

On the menu bar, select File → Export, and specify a file name in the Save as dialog box to export 

the data in a CSV file. In addition, the tool can import and edit the Antenna Factor correction data 

that was once exported. 

The first row of the file to be exported is a header row including the frequency unit character string. 

(Note: Refer to “Import.”) 

 

 

 

 

For the frequency unit 
character string, specify one of 
the following: 
Hz, kHz, MHz 
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11－5. Editing Correction Data 

 

Set frequencies 
① Checking Consistency Between Records 

Since the frequencies set for the records are checked when creating a data file, be sure to set 
the frequency of the following record to a larger one than that of the previous record. 

 
 
 
 
 
 
 
 
② Treatment of fractions 

If the number of significant digits of a set frequency is seven or more, the first seven digits can be 
rounded to six digits. 
 

③ Checking the maximum and minimum settings 
The maximum and minimum set frequencies are checked. 
The minimum and maximum set frequencies are 1 Hz and 32 GHz, respectively. 
 

Level correction values 
① Positive/negative numbers 

Specify plus or minus relative values to the reference level (usually 0 dB) for level correction 
values. Plus and minus values are displayed in blue and red, respectively. 

 
 
 
 
 
 
 
 
② Treatment of fractions 

Level correction values can be rounded to two decimal places. 
 

③ Checking the maximum and minimum settings 
The maximum and minimum level correction values are checked. 
The minimum and maximum level correction values are -320 dB and 32 dB, respectively. 

Set the frequency of the following 
record to a larger one than that of 
the previous record. 
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11－6. Sample Antenna Factor 

The following is a sample Antenna Factor corresponding to characteristic curve data. 

Frequency characteristic curve 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Antenna Factor corresponding to the above 
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12. Specifications 
 

12－1. Specifications 

 
Control software, PC, and camera 

Item Specifications 

Image size 640 × 480 pixels 

Image division size 10, 16, 20, 32, 40, 80, or 160 pixels 

Capturing type Single / Free Run / Peak Hold / Max Hold 

Measurement unit dBµV / dBm 

Camera image display Still image / Video 

Secondary functions Save / Import / Export / Comment 

Supported OS Windows 7 / 8.1 / 10 
 

12－2. System Requirements 

 
OS : Microsoft® Windows® 7, 32 bit / 64 bit (Japanese / English version) 

Microsoft® Windows® 8.1, 32 bit / 64 bit (Japanese / English version) 
Microsoft® Windows® 10, 32 bit / 64 bit (Japanese / English version) 

CPU : Dual Core 2.4 GHz or faster recommended 
Memory : 4 GB or more recommended 
Hard disk : 1 GB or more 
Display : 1366 × 768 dots or more 

 
Other requirements: 
� 1 pointing device, such as a mouse 
� 1 DVD drive 
� 2 or 3 empty USB ports 

 
 

12－3. Supported Spectrum Analyzers 

 
Rohde & Schwarz FSV 

ESR 
ESRP 

Advantest U3741 
U3751 

Keysight N9010A 
Tektronix MDO4000series 
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12－4. Antenna Frequency Characteristics 

 
Model Probe Type Primary Sensor Structure Recommended 

Frequency Band 
901 6 cm Loop 

H-Field 
Shielded Loop 3 MHz ～ 500 MHz 

902 3 cm Loop Shielded Loop 5 MHz ～ 1 GHz 
903 1 cm Loop Shielded Loop 10 MHz ～ 3 GHz 
904 3.6 cm Ball 

E-Field 
Spherical Dipole 10 MHz ～ 3 GHz 

905 6 mm Stub Tip Short Monopole 50 MHz ～ 3 GHz 
 
 
■100 kHz ～ 1 MHz 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

901（6 cm Loop） 902（3 cm Loop） 

903（1 cm Loop） 904（3.6 cm Ball） 

905（6 mm Stub Tip） 
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■100 kHz ～ 100 MHz 
 
 
 
 
 

901（6 cm Loop） 902（3 cm Loop） 

904（3.6 cm Ball） 903（1 cm Loop） 

905（6 mm Stub Tip） 
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■100 kHz ～ 3 GHz 
 
 
 
 

901（6 cm Loop） 902（3 cm Loop） 

903（1 cm Loop） 904（3.6 cm Ball） 

905（6 mm Stub Tip） 
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13. Warranty 
 

Warranty 
   
A warranty is provided for the software produced by NoiseKen and its update files under the 
following terms and conditions. This warranty is valid in Japan only. 

 
 

1. Scope of Warranty 
This warranty applies to the software produced by NoiseKen and its update files. 

 
2. Free Support 

If a fault occurs in the system as a result of this software by NoiseKen, NoiseKen will 
provide support free of charge through software fixes and updates or other means only 
within the warranty period. However, please be aware that we may discuss when to 
implement corrective measures for minor issues. 

 
3. Total Maximum Liability 

If the customer incurs losses or damages due to a fault of this NoiseKen software 
purchased by the customer, unless the losses or damages are the result of willful or 
negligent actions, the maximum amount of NoiseKen’s liability for compensation for 
these losses or damages to the customer is equal to the amount that the customer paid 
for this NoiseKen software. But, NoiseKen assumes no liability for any losses or 
damages incurred by the customer due to faults arising from this software by NoiseKen, 
including but not limited to, direct or indirect potential lost earnings and direct or indirect 
damages due to third party claims for compensation against the customer. 

 
4. Warranty Period 

The warranty period is the support period of the OS by the provider (including extended 
support periods) for the OS where operation is guaranteed by NoiseKen. When the 
support period of this OS ends, support for this software in this OS will also come to an 
end. 
Support for the target software will also end when manufacturing of this NoiseKen 
product is discontinued. 
 

5. Exclusions 
These terms and conditions do not constitute a full and complete guarantee of operation 
or compatibility with the customer’s system. Also, the following situations are outside the 
scope of support. 
[Combining with products other than those recommended by NoiseKen] 
Although every effort will be made to provide comprehensive software support, some 
faults may be unable to be resolved due to lack of compatibility or conflicts with PCs, 
peripherals, and other hardware, and OS and other software. 
[Added functions and OS upgrades] 
Please note that support for added functions and OS upgrades are outside the scope of 
free support. 
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14. NOISE LABORATORY SUPPORT NETWORK 
 

� If a symptom which seems a trouble is found, check the symptom, software version, 

model name of connected device, and serial number, and inform this information to 

Noise Laboratory or your nearest sales agent of Noise Laboratory. 
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Note                                           
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